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Installation Overview

Preventive Controls Governor (PCG) is a set of applications that run within Oracle
E-Business Suite. These applications include:

* Form Rules, which modifies the security, navigation, field, and data properties
of Oracle EBS forms.

*  Flow Rules, which defines and implements business processes.

* Audit Rules, which tracks changes to the values of fields in database tables that
underlie Oracle EBS.

* Change Control, which regulates changes to the values of fields in Oracle EBS
forms. It can monitor change, require a reason for a change, or require approval
for a change.

In the background, PCG also provides “User Provisioning” functionality employed
by a separately installed product, Application Access Controls Governor.

PCG components are installed on the forms and concurrent manager servers on which
Oracle EBS runs. The installation process implements the following architecture:

» Database Schema: Installation requires the identification of a schema for use by
PCG applications. You are strongly advised to create a new schema named
XXLAAPPS. However, you may use a schema that has already been established
for third-party products.

+ Tablespace: You are advised to create a tablespace for indexes used by PCG data-
base objects. (An already established tablespace may be used.)

+ Database Objects: PCG makes use of database tables, packages, sequences, and
workflows, which are placed in the XXLAAPPS (or user-specified) schema.

* Application Server Objects: PCG uses custom forms, which are installed on the
application server. Custom forms are located in the $XXLAAPPS TOP/forms/US
directory.

* Program Executables: PCG uses program executables to report on, migrate, and
compile business rules. The following objects are installed on the concurrent
manager server (typically the database server): reports, programs, and Java files.
Custom programs are located in the $XXLAAPPS_TOP/forms/US directory; some
executable programs may also reside in the $XXLAAPPS TOP/bin directory.
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Two comprehensive Installer programs place PCG applications on the concurrent
manager server and forms server. (They also install a rules engine that provides
functionality to the applications.) Each Installer may be run in any of three modes:

GUI: The Installer programs present a series of windows that prompt for infor-
mation necessary for the installation. Each window also provides access to a
help window. As you progress through the windows, you can return to windows
you had completed earlier in order to review or change the entries in them. (The
Installers retain any entry you don’t change, even if you return to a step earlier
than the one in which such an entry was made.) GUI mode is the default.

Console: The Installer programs present a series of prompts in a command con-
sole, in response to which you provide information necessary for the installation.
Console mode prompts for the same information as GUI mode, but does not
enable you to return to earlier prompts and does not provide help screens.

Silent: The Installer programs read parameters from properties files, and then
run without user interaction.

To run each Installer program, you would type its name — ladbinstall.bin or
lafrminstall.bin — at the command prompt. The name alone launches GUI mode if
no properties files are present, or silent mode if properties files are present; the
name along with the argument -i console launches the console mode.

Preparatory Procedures

Before installing Preventive Controls Governor, ensure the following;:

Grant the following APPS schema objects the execute privilege to the PCG
schema:

— FND_FILE — Package Spec and Body

— FND_PROFILE — Package Spec and Body

Confirm that Java is in your path. Type the following at the command prompt:
which java

Verify that you use Java version 1.4 or higher. Type the following at the
command prompt:

java -version

If more than one copy of Java exists on your system, verify the version of the
copy in the opt directory (for example, /usr/optl.4/bin/java).

Each of your database server, forms server, and concurrent manager server may
run on its own host machine. If so, complete the following tasks to confirm that
the host machines communicate properly:

— Send a file via FTP from the database server to the concurrent manager
server, and from the concurrent manager server to the forms server.

— Perform a remote execution of the shell file, by any of the following
methods: Enable rsh (remote shell), enable ssh (secured shell), have a
common mount point, manual.
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Sizing Considerations

Make sure your forms server has 100 megabytes (MB) of disk space for PCG files,
and the concurrent manager server has 100 MB of disk space for PCG executable files.

Moreover, the PCG schema requires the following amounts of disk space:
* 100 MB for most PCG database tables.

* An additional 1 gigabyte (GB) for two temp tables used in Audit Rules
processing — LAAD_AUDIT_KEYS and LAAD_AUDIT VALUES.

The GRC Controls schema (XXLAAPPS or user-specified) requires space to encompass
shadow tables used by Audit Rules — one-third the space taken by each audited table.

Software Requirements

Each instance of Preventive Controls Governor runs with an instance of Oracle E-
Business Suite. Versions 12.04 and 11.5.10.2 are certified, and version 11.5.9 is
supported. If you use a version earlier than 12.04, you must install patch number
5472959, which is available on Metalink.

The following operating systems are preferred for PCG:
* Red Hat Linux AS/ES 3.0

* Red Hat Linux AS/ES 4.0

* Solaris 8/9/10

The following operating systems are also supported:

* Suse Linux Enterprise Server 9.0

« AIX

+ HP-UX

Each PCG instance requires an Oracle 9i (or later) database.

Obtaining Installation Files

In your Oracle media pack, locate the Governance, Risk, and Compliance Controls
Suite Disk. In its dist directory, locate the file pcg_73 o0s.zip, in which the
placeholder os is replaced by the name of the operating system on which you are in-
stalling. Copy the file to a temporary directory on your local system. From it, extract
the two files — ladbinstall.bin and lafrminstall.bin — you will run for concurrent man-
ager and forms installation. If you intend to use the silent installation mode, also extract
the two files from which the Installers will read parameters — ladbinstall.properties
and lafrminstall.properties.

Preparing Properties Files

If you intend to run the Installer programs in silent mode, you need first to edit the
two properties files you extracted from pcg_73 os.zip, inserting information
specific to your installation. (If you intend to use GUI or console mode, you don’t
need the properties files, and you can ignore this section.)
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To insert values in the files, use a text editor. Each file consists of a series of name-
value statements, each of which sets a parameter name equal to a value and each of
which is preceded by an explanatory comment. (Each comment begins with a #
symbol.) In each statement, edit information to the right of an equals sign; do not
(with one exception, discussed below) modify text to the left of the equals sign.

Insert into the files exactly the same information as you would supply in response to
prompts if you were to run the Installers in GUI mode. For detailed descriptions of
that information, see Chapter 2, “Installing Preventive Controls Governor.”

The two properties files — ladbinstall.properties (concurrent manager) and
lafrminstall.properties (forms) — share many parameters, which correspond as
follows to the GUI prompts discussed in Chapter 2:

* CUST NAME and LICENSE KEY: Prompts in the License Key window, step 1 on
page 2-4 (concurrent manager), or step 1 on page 2-8 (forms).

* #STAGE_DIR: Prompt in the Staging window, step 2 on page 2-4 (concurrent
manager), or step 2 on page 2-9 (forms).

This statement is the exception to the rule that you should leave parameter names
intact. In the assumption you will want the Installers to set default staging
directories, this statement is commented out in the properties file. To use the
statement, you must not only supply a staging directory path to the right of the
equals sign, but also delete the # symbol at the beginning of the statement.

* DB _HOST NAME, DB_SID, and DB_PORT: Prompts in the Database Host window,
step 3 on page 2-5 (concurrent manager), or step 3 on page 2-9 (forms).

* DB _XXLAAPPS_SCHEMA NAME, DB_XXLAAPPS_PASS, DB_APPS_SCHEMA NAME,
and DB_APPS PASS: Prompts in the Database Schema window, step 4 on page
2-5 (concurrent manager), or step 4 on page 2-9 (forms).

Another exception: The concurrent-manager-installation window does not
prompt for the Oracle EBS schema name, although the forms-installation win-
dow does. The properties file requires it (typically APPS) as the value for the
DB_APPS_SCHEMA NAME parameter.

*  XXLAAPPS SHORT NAME and APPL_TOP: Prompts in the Application TOP win-
dow, step 5 on page 2-6 (concurrent manager), or step 5 on page 2-9 (forms).

*  ENVFILE and ADOVARS: Prompts in the Environment window, step 6 on page
2-7 (concurrent manager), or step 6 on page 2-10 (forms).

The ladbinstall.properties file contains one parameter — INDEX TABLESPACE —
that does not appear in lafrminstall.properties. This parameter corresponds to the
Index Table Space prompt in step 4 on page 2-5.

The lafrminstall.properties file contains two parameters that do not appear in the
ladbinstall.properties file. These two parameters correspond as follows to the GUI
prompts discussed in Chapter 2:

e APPSORA: The final prompt in the Environment window, step 6 on page 2-10.

*  CUSTOM_CHOICE: The prompt in the CUSTOM.pll window, step 7 on page 2-10.
In the properties file, any value other than No (case-sensitive) is equivalent to Yes.

Finally, both files contain a parameter that does not correspond to any GUI prompt.
For you to run the Installers in silent mode, an INSTALLER UI parameter must be set
to the value silent. This is the default; don’t change it.

1-4 Oracle Preventive Controls Governor Installation Guide



2

Installing Preventive Controls Governor

In broad terms, the PCG installation process involves four steps:

1. Create a tablespace for PCG indexes, and a custom database user/schema. The
user/schema name XXLAAPPS is strongly recommended.

2. Run the Installer program to place PCG tables, packages, sequences, and
workflows on the concurrent manager server. All the table names begin with the
prefix LA, and all tables reside in the PCG schema (typically XXLAAPPS). The
concurrent manager server installation must precede the forms server installa-
tion.

3. Run the Installer program to place PCG forms on the forms server. All custom
forms are located in the $XXLAAPPS_TOP/forms/US directory.

4. Configure a remote compilation feature, which makes libraries resident on the
concurrent server available to the forms server.

Creating a User and Tablespace

After extracting installation files from pcg 73 os.zip, and editing the properties
files if you intend to use silent mode (see “Obtaining Installation Files” on page 1-3
and “Preparing Properties Files” on page 1-3), create the PCG tablespace and
database user/schema. The latter must be granted the connect and resource privileges
in the Oracle EBS database. You are strongly advised to use the name XXLAAPPS for
the new user, and to create all PCG database objects in the XXLAAPPS schema.

The following is a sample SQL script that can be used to create the user:

CREATE USER XXLAAPPS

IDENTIFIED BY XXLAAPPS

DEFAULT TABLESPACE &DEF TSPACE
TEMPORARY TABLESPACE &TMP TSPACE
QUOTA UNLIMITED ON &DEF TSPACE
QUOTA OK ON SYSTEM;

GRANT CONNECT TO XXLAAPPS;

GRANT RESOURCE TO XXLAAPPS;
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If you are installing the PCG on an instance of Oracle E-Business Suite Release 12,
the user-creation script should also include the following commands:

GRANT SELECT ON GVSINSTANCE TO APPS;
GRANT SELECT ON ALL OBJECTS TO XXLAAPPS;
GRANT SELECT ON DBA OBJECTS TO XXLAAPPS;
GRANT SELECT ON ALL TABLES TO XXLAAPPS;
GRANT SELECT ON ALL VIEWS TO XXLAAPPS;
GRANT CREATE VIEW TO XXLAAPPS;

Allocate a minimum of 80 MB of space, 40 on the tmp directory and 40 on the file
system from which the installer is to be launched.

Oracle E-Business Suite Release 12

If you are installing Prevetive Controls Governor on an instance of Oracle E-Busi-
ness Suite Release 12, complete the following steps before running the installation
programs. If you are installing on an earlier version of Oracle EBS, omit these steps
and skip ahead to the next section, “Installing Concurrent Manager Server Compo-
nents.”

1.

Execute the environment file, if it is not included in the profile:

$. SAPPL TOP/SAPPLFENV

At the operating-system command prompt, use the make-directory command to
create a custom application top (the high-level directory for the storage of PCG
files).

Its form must be the full path to the Oracle APPL_TOP; then, as a subdirectory,
the PCG database user name; and finally, as a subdirectory at the next level, the
the value 7/2.0.x. For example, if the Oracle APPL_TOP were /oracle/bin/
ebiz12/appl, the PCG database user name were XXLAAPPS, and the Oracle EBS
release were 12.0.4, the following command would create the custom applica-
tion top:

mkdir /oracle/bin/ebizl2/appl/xxlaapps/12.0.x

Export the custom application top path in the environment file (which is named
for the database SID and host name, with a .env extension, and is located in the
Oracle APPL_TOP directory). If the path in step 1 were the custom top, the
environment-file entry would look like this:

XXLAAPPS TOP="/oracle/bin/ebizl2/appl/xxlaapps/12.0.0"
export XXLAAPPS TOP

In the directory $APPL_TOP/admin, locate topfile.txt; open it for editing. Add an
entry that sets the relationship of the Embedded-Agent-database-user-name sub-
directory to the APPL_TOP directory. In the current example:

xxlaapps /oracle/bin/ebizl12/appl/

In the directory $APPL_TOP/admin, create the file applcust.txt. Open it for
editing, and insert the same entry as you did in step 4.
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6. Navigate to the SADMIN_SCRIPTS HOME directory and, from it, run three scripts.
Each prompts for the APPS password or the APPS username and password.

* adstpall.sh
* adautocfg.sh
* adstrtal.sh

Installing Concurrent Manager Server Components

To install PCG components on the concurrent manager server, run the file
ladbinstall.bin. (Although the Installer displays windows labeled “GRC Controls
Database Install,” it actually places files on the concurrent manager server.)

1. Transfer the ladbinstall.bin file to the concurrent manager server, via FTP in
binary mode. Use the applmgr account.

2. Use applmgr to log in to the concurrent manager server. Ensure that the user
(login ID) has write and read privileges on $APPL_TOP.

3. Execute the environment file, if it is not included in the profile:
$. SAPPL TOP/$APPLFENV

4. Set the execute permission on ladbinstall:
$ chmod +x ladbinstall.bin

5. Execute ladbinstall.bin:

* Torun in GUI or console mode, ensure that ladbinstall.properties is absent
from the directory where ladbinstall.bin resides. To run in silent mode, be
sure that both files are in the same directory.

e Use the name ladbinstall.bin as the command to run in GUI or silent mode.
Add the argument -i console to run in console mode.

All three Installer modes require the same information; GUI and console prompt for
it, and silent reads it from files. If you choose GUI mode (as shown in the following
procedure), you can perform these operations in each of the windows:

* Review a brief description of the information you need to provide.

*  Click on the Help button to open a window that provides a more expansive
description of the information you need to provide. (After you review this
information, click on the Close button to exit the Help window.)

*  Type installation information in the labeled text boxes (or accept default
values).

*  When you complete one window, click on the Next button to move from it to
the next window.

*  Click the Previous button if you wish to return to a window you completed
earlier.

* Note that titles of windows you have completed appear in black along the left of
each window; those yet to be completed are shown in grey.

Installing Preventive Controls Governor 2-3



To complete the concurrent manager server installation:

1. In the License Key window, enter Oracle as the Customer Name and the follow-
ing case-sensitive value as License Key: 6MR6457YESRJO1C8T3JhY2xl. A mes-
sage displays the applications you can install; click the OK button to clear it.

Enter the customer name and licenze key that you have received.
Both the fields are caze sensitive,

Customer Mame

Licenze Key

e 0w}

Specify a staging directory, which is a temporary location for
GRC Contraols source files during the installation process,

fexportshoneloracledrk stage/IB_07Nec2005_134434 |

Restore Default Folder || Choose, ..

The Installer suggests a default directory; its name is a timestamp for the
moment you perform the installation, with DB. If you wish to select another
directory, click the Choose button and, in a Select a Folder window, navigate to
the directory you want. If you specify a nonexistent directory, the Installer
creates that directory. If you navigate away from the default directory and want
to return to it, click on the Restore Default Folder button.

2-4 Oracle Preventive Controls Governor Installation Guide



3. Verify the default values for the host name, SID (service identifier), and
network port of the Oracle EBS database server, which the Installer takes from
the shell environment. If the defaults are not correct, enter correct values.

Specify the database host name, service 51D, and THS port of
the databaze in which GRC Controls applicationz are to be
inztalled,

Database Host Mame

|mammoth,uhq,logicalapps,com

SID
) |uisdb

| Fort
| |152

4. Supply log-on values for the PCG schema (in the GRC Controls Schema field)
and Oracle (APPS) schema:

Supply credentials for the GRC Controls schema and APPS
schema,

It iz strongly recommended that you use the name XELAARPPS for
the GRC Controls schema,

GRC Controls Schema
| HHLARPPS

Password|

Oracle APPS Schema Pazsword

Index Table Space

e [ e |

As noted earlier, the creation of a dedicated PCG schema called XXLAAPPS is
strongly recommended. The Installer provides this value by default. If you
follow the recommendation, accept the default; otherwise, replace it with the
name of the schema you will use for PCG database objects. Also enter the
passwords for the PCG and Oracle APPS schemas, and the name of the
tablespace for indexes used by PCG database objects.
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5. Establish the GRC Controls TOP — the high-level directory for the storage of
PCG files. Specify a directory that is the parent of the GRC Controls TOP and an
application short name that is appended to the parent directory to form the GRC
Controls TOP directory.

~| GRC Controls Database Install | i |

Application TOP

ﬂLicense key GRC Controls TOP will be created based on the input given
ﬂ Staging below,

ﬂ Database Host
Database Schema
Application TOP
wd, EN i ronmenit

ﬂ Input Summary

fﬂ Instal

1t iz strongly recommended that GEC Controls be installed az a
new custom application ¥XLAAPPS

Custom Application Short Name
| KHLAGPPS | &

GREC Controls Application TOP Directory Location
| foracle/bindebiz11h/appl |

Restore Default || Choose, .. |

InstallAnyuhere by Zero G S
| Cancel | | Help |

By default, the Installer selects the Oracle EBS TOP as the parent directory and
XXLAAPPS as the application short name. These are the recommended values,
but you can change them. If you are installing on Oracle Release 12, these
values must match the APPL_TOP and immediate subdirectory you configured
carlier (see page 2-2), but not the release-level value (such as 12.0.0).

To select another parent directory, click on the Choose button and, in a Select a
Folder window, navigate to the directory you want. If you enter the name of a
nonexistent directory, the Installer creates that directory. To return to the default
directory, click the Restore Default button.

No matter what case you use to enter values, the Installer saves the short name
as all uppercase (and adds the uppercase TOP to create a top shell variable), and
the directory location as all lowercase. (However, for a reinstallation, the Installer
does not change the case of an existing application TOP.)

If you have selected an application short name that is already in use, the
Installer displays a warning message when you click the Next button:

To respond to this warning:

*  Click Enter Again to return to the Application TOP form and set a new
value.

*  Click Continue to accept the duplicate application short name. Doing so,
however, would cause PCG and another application to share the name, with
the risk that files for one application or the other might be overwritten.

*  Click Abort to abandon the PCG installation.
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6. Specify paths to files that contain environment variables for the Oracle EBS
shell. (The installation adds PCG-specific entries to these files.)

Pleaze enter the erwironment files that set the Oracle
Applications shell environment

GRC Controls environment settings to be weitten to
| foraclesbindebiz110¢applAvizdb_mammoth, ey |

| Restore Default | | Choose, .. |

Oracle adovars file

T LI TN

1 | foraclesbindebiz110/appl/adnin/adovars, eny |

| Restore Default | | Choose, .. |

Accept the defaults, or click a Choose button and, in a Select a Folder window,
navigate to a directory you want. If you enter the name of a nonexistent
directory, the Installer creates that directory. To return to the default directory,
click the Restore Default button.

7. Review your selections in the Input Summary form:

Please review the following carefully before continue

GRC Controls Schema
XXLAAPPS

Oracle's APPS Schema
APPS

Tablespace to create indexes in
LAAPPS

Datahase Host Name
mammaoth who.logicalapps.com

Oracle SI1D
vigdh

Staging Directory
fexporthomed/orasie/rkstage/DB_07Des2006_134434

If you determine that any entry is inappropriate, you can click on the Previous
button until you reach the form in which you selected the entry, and change it.
(The Installer retains any entries you don’t change, even if you pass by them as
you return to an earlier step in the installation process.)

Installing Preventive Controls Governor 2-7



8. In the Input Summary form, the label for the button at the lower right has
changed from Next to Install. When you are satisfied with your selections in
earlier forms, click on the Install button to complete the installation.

The Installer displays error messages (if any are warranted) upon completing the
installation of each PCG application, and displays an overall status upon completing
the installation of all products. If the overall status is Success, the installation has
finished with no errors.

If errors occur, they or the overall status may be classified as Warning, Nonfatal, or
Fatal, depending on severity. The Installer recovers (restores the system to its state
prior to the installation) for Fatal errors, but not for Warning or Nonfatal errors. For
details about errors and the installation process, navigate to the directory from
which the Installer ran and review two log files: LADB LOG _timestamp.log and
LADB_ERROR _timestamp.log, where timestamp is the date and time at which the
Installer ran.

Installing Forms Server Components

2-8

To install PCG forms server components, run the file lafrminstall.bin:

1. If the concurrent manager and forms servers run on the same host, re-source the
environment by opening a new shell.

2. Transfer the lafrminstall.bin file to the forms server, via FTP in binary mode.
Use the applmgr account.

3. Use applmgr to log in to the forms server. Ensure that the user (login ID) has
write and read privileges on $APPL_TOP.

4. Execute the environment file, if it is not included in the profile:

$. S$APPL TOP/$APPLFENV

5. Set the execute permission on lafrminstall:

$ chmod +x lafrminstall.bin
6. Execute lafrminstall.bin:

* To run in GUI or console mode, ensure that lafrminstall.properties is absent
from the directory where lafrminstall.bin resides. To run in silent mode, be
sure both files are in the same directory.

»  Use the name lafrminstall.bin as the command to run in GUI or silent mode.
Add the argument -i console to run in console mode.

Most windows (or console prompts) for the forms installation are identical to those
for the concurrent manager installation. If you select GUI mode, you perform the
same operations in each window as you did for the concurrent-manager-server
Installer.

To complete the forms server installation:

1. In the License Key window, enter Oracle as the Customer Name and the follow-
ing case-sensitive value as License Key: 6MR6457YESRJO1C8T3JhY2xl. (These
are the same as the values for concurrent-manager-server installation.) A mes-
sage displays the applications you can install; click the OK button to clear it.
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2.

In the Staging form, once again select a directory for the temporary placement
of source files. The Installer once again suggests a default — its name a time-
stamp for the moment you perform the installation, along with FRM (for forms).

If you wish to select another directory, click on the Choose button. In a Select a
Folder window, navigate to the directory you want. If you specify a nonexistent
directory, the Installer creates that directory. If you navigate away from the default
directory and want to return to it, click on the Restore Default Folder button.

In the Database Host form, select the database host name used where the concur-
rent manager installation has been run, and the appropriate SID and port values.

In the Database Schema window, there is no longer an Index Table Space field
(as it would be inapplicable to forms installation), but where the concurrent-
manager-server Installer requested only a password for the Oracle EBS schema,
the forms-server Installer asks for a name as well:

_| GRC Controls Forms Install | : |

Database Schema

License key Supply credentials for the GRC Controls schema and APPS
Staging schema,
ﬂ]]atabase Host It iz strongly recommended that you use the name XELAARPPS for

the GRC Control hema,
m]]atabase Schema ® onLrots senena

Application TOP
2e ENUironment
3 CUSTOM, p11

m Input

GRC Controls Schema
| HLARPPS | &

Password | |

Appz Schema I B
|APFS | =

Pazsword | |

InztallAnywhere by Zera G e —— e
| Cancel | | Help | 5 ._ | Previous |-_E]

For the Apps Schema field, accept the default value, APPS. (This needs to match
the concurrent-manager-server value, which is hard-coded.) For each remaining
field, enter the value you entered for concurrent-manager installation.

Once again, the creation of a dedicated schema called XXLAAPPS is recommended.
To follow this recommendation, accept the default value; otherwise replace it
with the name of the schema you will use for PCG database objects. Also enter
the passwords for the GRC Controls and Oracle APPS schemas.

In the Application TOP form, establish the GRC Controls TOP for the forms
server — the highest-level directory for the storage of PCG files. Specify a
parent directory of the GRC Controls TOP, and an application short name that is
appended to the parent directory to form the GRC Controls TOP directory.

The Installer defaults to the forms-server-specific Oracle EBS TOP as the parent
directory and XXLAAPPS as the application short name. These values are
recommended.
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Ensure that the application short name for the forms server is the same as the
concurrent manager server’s. If you wish to select another parent directory,
click on the Choose button and, in a Select a Folder window, navigate to the
directory you want. If you enter the name of a nonexistent directory, the
Installer creates that directory. To return to the default directory, click the
Restore Default button.

No matter what case you use to enter values, the Installer saves the short name
as all uppercase (and adds the uppercase TOP to create a top shell variable), and
the directory location as all lowercase. (However, for a reinstallation, the
Installer does not change the case of an existing application TOP.)

The forms-server Installer, like its concurrent-manager-server counterpart,
presents a warning if you select an application short name that is already in use
and it presents the same response options:

*  Click Enter Again to return to the Application TOP form and set a new value.

*  Click Continue to accept the duplicate application short name. Doing so,
however, would cause PCG and another application to share the name, with
the risk that files for one application or the other might be overwritten.

*  Click Abort to abandon the PCG installation.

In the Environment form, specify paths to files that contain environment
variables for the Oracle EBS shell (the first two prompts) and for forms paths
(the APPSORA prompt). Accept the defaults, or click a Choose button and, in a
Select a Folder window, navigate to a directory you want. If you enter the name
of a nonexistent directory, the Installer creates that directory. To return to the
default directory, click the Restore Default button. In any case select values that
are appropriate for the forms server.

When you complete the Environment form, the forms server Installer presents a
CusTOM.pll form:

_| GRC Controls Forms Install | : |

CUSTOM.pLL

License Key Fleaze chooze "Yes™ to owerwrite the existing CUSTOM.pll with
Staging CUSTOM,pll provided by Oracle.

ﬂ]]atabase Host Choozing "Mo” will leawe the existing CUSTOM,pll az it is,
ﬂ Database Schema
ﬂ fpplication TOP
ﬂ Erwironment.
[33 cusTaH, pl1

Overwrite CUSTOM,pl17?

m' Input. ® Ves =
1 Ho
Inztallfnyuhere by Zero G —_— '"_",m:h._-_-f:;-__-i;'_:__'- —
Cancel | | Help 5 ._ Previous |3 Mext j
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Forms server installation requires that an existing CUSTOM.pll file be modified
so that it can link to an LACUSTOM.pll file. If you select Yes, the Installer backs
up your existing CUSTOM.pll, and then overwrites the original with a modified
copy that contains the necessary links to LACUSTOM.pll. (The backup copy has a
timestamp appended to the .pll file extension.) If your existing CUSTOM.pll
contained any customization, a Yes selection in this form would require you to
copy your customizations manually from the backup file to the new version of
CUSTOM.plL.

If you select No, the Installer retains your existing CUSTOM.pll. In this case, you
need to edit the file to insert links to LACUSTOM.pll (see below).

8. In the Input Summary form, review the selections you have made. If you
determine that any entry is inappropriate, you can click on the Previous button
until you reach the form in which you selected the entry, and change it. (The
Installer retains any entries you don’t change, even if you pass by them as you
return to an earlier step in the installation process.)

9. When you are satisfied with the selections you have made in preceding forms,
click on the Install button in the Input Summary form to complete the forms
server installation.

The Installer displays error messages (if any are warranted) upon completing the
installation of each PCG application, and displays an overall status upon completing
the installation of all products. If the overall status is Success, the installation has
finished with no errors.

If errors occur, they or the overall status may be classified as Warning, Nonfatal, or
Fatal, depending on severity. The Installer recovers (restores the system to its state
prior to the installation) for Fatal errors, but not for Warning or Nonfatal errors. For
details about errors and the installation process, navigate to the directory from
which the Installer ran and review two log files: LAFRM_LOG _timestamp.log and
LAFRM_ERROR _timestamp.log, where timestamp is the date and time at which the
Installer ran.

custom.pll Modifications

If you chose (in step 7) not to overwrite your CUSTOM.pll file, edit the CUSTOM.pll
file. (If you selected Yes in step 7, ignore this section and skip ahead to “Configur-
ing the Remote Compilation.”)

1. In place of the existing code for Procedure Event(event _name varchar2),
substitute the following:

PROCEDURE event (event name varchar2) is
form name varchar2(30) := name in('system.current form');
block name varchar2 (30) name in('system.cursor block');
field name varchar2 (30) := name in('system.current item');
function name varchar2 (30) ;
parameters varchar2 (2000) ;

begin
if (event name = 'ZOOM') then
la enhncmtmgr pkg.la zooms (form name,block name,
function name, parameters);
if function name is not NULL
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then
if parameters is null then
fnd function.execute (function name,'Y','N'");

elsif 'ZOOMSPECIAL' = substr(parameters,1l,11) then
lacustom.event ('ZOOMSPECIAL'); —----- new code 081903
else
parameters := lazoom.zoom event (parameters) ;
fnd function.execute (function name, 'Y', 'N', parameters);
end if;
end if;
——————————————————————————————————— WNF

elsif (event name='WHEN-NEW-FORM-INSTANCE') then
lacustom.event ('WNE') ;

——————————————————————————— WNB
elsif (event name = 'WHEN-NEW-BLOCK-INSTANCE') then
lacustom.event ('WNB') ;
—————————————————————————————— WNI
elsif (event name = 'WHEN-NEW-ITEM-INSTANCE') then
lacustom.event ('WNI') ;
———————————————————————— WNR
elsif (event name = 'WHEN-NEW-RECORD-INSTANCE') then
lacustom.event ('WNR'") ;
———————————————————————— WNV
elsif (event name = 'WHEN-VALIDATE-RECORD') then
lacustom.event ('WVR") ;
elsif (substr(event name,1,7) = 'SPECIAL') then

execute menu (event name);
else lacustom.event (event name); --put other events here
end if;

end event;

2. In place of the code for Function zoom_available, substitute the following:

FUNCTION zoom available return boolean is
v_enabled wvarchar2(20);
begin -—X
v_enabled := lazoom.zoom enabled;
IF v_enabled = 'TRUE' THEN
return TRUE;
else
return FALSE;
end 1if;
RETURN NULL;
end zoom available;

3. Attach the following libraries. (Remove the path when attaching the libraries.)
*  LACUSTOM.pll
*  LABRSQL.pll

4. Compile the file and ensure there are no compilation errors.
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Servlet Mode

If the forms server runs in servlet mode, you must edit a file to enable Oracle to recog-
nize the GRC Controls TOP you selected during installation (see step 5 on page 2-9).

To determine whether the forms server runs in servlet mode, identify the file repre-
sented by the Oracle environment variable SFORMS60 WEB_CONFIG_FILE. Open that
file and search for its serverURL entry. If that entry is set to the value /forms/formserviet,
the forms server runs in servlet mode. If the entry is blank, the forms server runs in
socket mode, in which case you need not complete the following procedure.

If the forms server runs in servlet mode:

1. Using a text editor, open a file called formservlet.ini. The file is located either in
$APACHE_TOP/Jserv/etc or in $IAS_ORACLE_HOME/Apache/Jserv/etc.

2. In the formservlet.ini file, look for a block of entries bounded by the lines #Begin
Customization and #End Customization.

3. Add the following entry anywhere between the Begin and End Customization lines:
XXLAAPPS TOP=$APPL TOP/xxlaapps/11.5.0

Note, however, that the value XXLAAPPS is correct in this entry only if you have
accepted the default application short name during installation. If not, then in
each of the two places that the value XXLAAPPS appears in this entry (whether in
upper or lower case), substitute the short name you created in step 5 on page 2-9.

4. Save and close the file.

Configuring the Remote Compilation

To finish the installation, you must configure a remote compilation feature, which
makes libraries resident on the concurrent server available to the forms server.

1. Log on to the concurrent manager server.
2. Source out the Oracle EBS shell environment.

3. Navigate to the $XXLAAPPS_TOP/bin directory (a subdirectory, called bin, of the
GRC Controls TOP directory, which you established in step 5 of the concurrent
manager server installation process).

4. Grant the execute permission on a file called laconfig.sh:
$ chmod +x laconfig.sh

5. Run the laconfig.sh file:
$ laconfig.sh

Running the laconfig.sh file produces a series of command-line prompts. Respond
to them as follows:

1. You are prompted to enter the GRC Controls application short name. If that
name is other than XXLAAPPS, type it and press the Enter key. (Case is not
significant.) If the short name is XXLAAPPS, simply press the enter key in
response to the prompt.

2. A prompt displays a path to a Java executable; you must confirm that this is the
path to the Java executable used by Oracle EBS. 1t is, if you sourced out the
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Oracle EBSshell environment before running the laconfig.sh file (no matter how
many Java executables reside on your system). It may not be, if you did not
source out the Oracle EBS shell environment and have more than one Java
executable on your system.

If the prompt displays the path to the Oracle EBS Java executable, type Y (for yes)
and press the Enter key. If not, type N (for no), press the Enter key, then type the
full path to the Java executable used by Oracle EBS and press the Enter key again.

3. A prompt displays a path for a file that sets the Oracle EBS environment; you
must confirm that it is correct. The default value is taken from the shell as
$APPL_TOP/$APPLFENV, and this selection is always safe; to accept it, press ¥
(for yes) and press the Enter key. But what’s really at issue is the file that sets
the GRC Controls TOP, which is a subsidiary file of SAPPLFENV. You may wish
to specify it instead; if so, type N (for no), then type the full path to the appro-
priate file and press the Enter key.

4. The following prompt appears:

Choose your node configuration from below:
1. All servers (CM/Forms) share the same application top

directory

2. Forms server has different application top file system
than concurrent managers

3. Exit Program

Enter 1 if all database, forms, and concurrent servers exist under a single applica-
tion TOP, or 2 if each exists under its own application TOP (regardless of whether
they reside on a single machine or more than one).

5. You are prompted to enter the number of distinct application TOPs used by
forms servers. Type the number and press the Enter key.

6. For each of the application TOPs you include in the count in step 5, you are
prompted to select a method for transferring files to the application TOP direc-
tory. Enter one of the following and press the Enter key:

e 1 for secured shell (ssh)

» 2 for remote execution (rexec)
o 3 for telnet

* 4 for local file system (copy)
e 5 for manual

7. For each application TOP, you are prompted for supporting information if you
have selected any of the first four access methods. (Method 5, manual, requires
no supporting information.)

»  Server host name if you selected option 1, 2, 3, or 4

*  Full path to PCG binary files if you selected option 1, 2, 3, or 4
» User ID if you selected option 1, 2, or 3

» Password if you selected option 3

Entries are validated, so that if you enter incorrect supporting information you
are prompted to try again.
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When you finish executing the laconfig.sh file, verify that the following files exist:

Concurrent manager server (under $XXLAAPPS TOP/bin): LAGENLIB.prog,
LAMIGRATE.prog, LAIMPORT.prog, and GRC_BIP_RPT UPLOAD.prog

Forms server: LAFORMSGEN.prog

Finally, if you want to enable migration (the ability to port PCG configurations from
one instance to another) with password security:

1.
2.
3.

Navigate to \\System Administrator Responsibility\Profile\System.
Query for the LAAPPS: Enable Migration Security profile option.

Set the value to Yes at site level. (This can be controlled further at the
responsibility and user levels.)

Bouncing the Servers

When you finish configuring the remote compilation feature, bounce both the form
server and the concurrent manager server.

Postinstallation Tasks

Once the installation is complete, you must perform additional tasks. Some are
required in any case, and others only if you run particular versions of Oracle E-
Business Suite or if other special circumstances apply.

Run a Script

Run a script that removes obsolete components installed with PCG:

1.

In step 2 of concurrent-manager-server installation (page 2-4), you created a
staging directory. Navigate to the following subdirectory of that staging directory:

AppsCore\db\plsqgl

Using a SQL tool, connect to the PCG database, supplying the username and
password for the its user. For example, if the tool were SQLPlus:

connect xxlaapps/xxlaapps
Run the script Hide 722 AppsAccess.sql.
Log off the SQL tool.

Compile SQL Rules

From within PCG, you must run an option to compile SQL rules:

1.

Log on to the GRC Controls responsibility in Oracle E-Business Suite. In that
responsibility, select Form Rules.

A GRC Controls-Oracle Rules form opens. Select its Form Rules tab.

Click on Tools in the menu bar, and then Oracle Form Rules Compile All
Active SQL Rules in the Tools menu.
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A pop-up message informs you of an ID number for the concurrent request that
executes the SQL rule compilation. Make a note of the number, and then click
on the OK button to close the message.

Optionally, verify that the request has been completed successfully.
a Click on View in the menu bar, then on Requests in the View menu.

b A Find Requests form opens. In it, click on the Specific Request radio
button. Type the ID number of your concurrent request in the Request ID
field, and click on the Find button.

¢ A Requests form opens. In the row displaying information about your
request, ensure that the entry in the Phase field is Completed (you may need
to click the Refresh Data button), and the entry in the Status field is Normal.

d Close the Requests form: click on the x symbol in its upper right corner.

Associate a GRC Controls Function

In support of Application Access Controls Governor, PCG inserts an Activate Respon-
sibilities option in the Actions menu of the Oracle Users form. To activate this menu
option, associate a function called GRC Controls Activate Responsibilities with
either responsibilities or menus from which administrators open the Users form:

1.

In the GRC Controls-Oracle Rules form, ensure that either the Form Rules or
Flow Rules tab is selected.

Click on GRC Controls Utilities in the menu bar, and then on Mass Associate
Function in the Utilities menu. A Mass Associate Function form appears.

H I e e o o e e o e e e s

& Menu Responsibility

Function Name |GRC Controls Activate Responsibili

—Associate Function

Select All
Menu Include Exclude

Shop Floor Management i =

Shop Floor Super User

Spares Management Main Menu

|Slandard Report Submission and view report (privilege

|Sludenl Recruiting

|Supp|ier Drop Ship

Supplier Scheduling Superuser:

l System Administration 'S
System Administration Functions &
'TCA Main Menu w =

( Submit | I Cancel )

Click on the Menu or Responsibility radio button (to determine which type of
item you will associate with the function).

In the Function Name field, select GRC Controls Activate Responsibilities.

Select the Include radio button for each menu or responsibility you want to
associate with the function you’ve selected. By default, the Include radio button
is selected for all items in the Associate Function list. You can:

* Deselect or select all menus or responsibilities. Click on the Select All
check box so that it changes to read “Deselect All.” Then click on it again;
this selects all the Exclude radio buttons and clears all the Include radio but-
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tons, and it changes the check box label back to “Select All.”” Click on it once
again; this selects all the Include radio buttons and clears all the Exclude
radio buttons, and it changes the check box label back to “Deselect All.”

*  Deselect individual included menus or responsibilities by clicking on the
Exclude radio button for each.

* Select individual excluded menus or responsibilities by clicking on the
Include radio button for each.

6. Click the Submit button. Users with access to the newly associated menus or
assigned the newly associated responsibilities then have access to the function.

Change Control Wizard

In Preventive Controls Governor, a Change Control Wizard enables users to write
rules that impose change control on Oracle E-Business Suite fields. In order for the
Wizard to be used, you must run a Create Audit Rules Objects option:

1. In the GRC Controls-Oracle Rules form, ensure the Audit Rules tab is selected.

2. Click on GRC Controls Utilities in the menu bar, and then Create Audit Rules
Objects in the GRC Controls Utilities menu.

3. A pop-up message indicates that a concurrent request has been run. Make a note
of its number, and then click on the OK button to close the message.

4. Optionally, verify completion of the request. (See step 5 on page 2-16.)

Oracle E-Business Suite Version 11.5.10.2 or Later

If you run Oracle E-Business Suite version 11.5.10.2 or later, edit an .xml file
known as a “context file” in order for Oracle EBS to source the PCG environment.
(Sourcing is done through the use of a .env file, for which the context file serves as a
template. In earlier versions, a shell script served as the template; the PCG installer
worked with the shell script to set values automatically. Thus, complete this procedure
if you run Oracle EBS 11.5.10.2 or later; omit it if you run an earlier version.)

1. Using an xml editor, open the file SAPPL_TOP/admin/sid_host.xml. In this file
name, replace sid with the system identifier for the APPS database and host with
the host name of the machine on which the APPS database resides.

2. 1In the file, search for the value zx TOP.
3. Add the following line immediately beneath the ZX TOP row.

<XXLAAPPS TOP oa var="s xxlaappstop" oa type="PROD TOP"
oa_enabled="FALSE">$APPL TOP/xxlaapps/11l.5.0</XXLAAPPS TOP>

Note the following:

»  The value XXL44PPS is correct in this line only if you accepted the default
application short name during installation. If not, then in each of the four
places that the value XXLAAPPS appears in this line (whether in upper or
lower case), substitute the short name you created in step 5 on page 2-6.

» In place of the value SAPPL_TOP, supply the actual full path to the Oracle
EBS TOP directory.

4. Save the file.
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Audit Rules

218

Audit Rules affords database auditing not only to users, but also to other applica-
tions — Preventive Controls Governor and Access Monitoring. To prepare the audit-
ing functionality for use, complete the following tasks.

First, set an AuditTrail: Activate profile option to Yes:

1.
2.
3.

Log on to the System Administrator responsibility in Oracle E-Business Suite.
In the Navigator, select Profile, then System.

In the Find System Profile Values form, select AuditTrail:Activate in the Profile
list of values. Then click on the Find button.

Ensure that the AuditTrail: Activate option is set to Yes at the Site level:

Application Responsibility User

Praofile Site
||AuditTraiI:Activate ‘Yes |—

| e | 3

Second, add the LACSVREPORT style to the printer you will use for Audit Rules:

1. Inthe System Administrator responsibility, select Install, then Printer, then Register.
2. A Printers form appears. In its Printer field, select the printer you wish to use
with Audit Rules. Note the value that appears in the Type field when you select
the printer, and then click on the Printer Types button.
3. A Printer Types form appears. In its Type field, query for the Type you noted in
step 2. (Press the F11 key; enter the Type value in the Type field; press Ctrl+F11.)
4. 1In the Style list of values, select LACSVREPORT; the software automatically
supplies an associated value under Driver Name.
© Printers
Printer Type Description
J noprint HPLMSI
Type [HPLJ4SI
Description ‘PCL
— Printer Drivers
Style Driver Marne
[LACSVREPORT AT_EFT B
I \
| \
| \
( \ p
| \ B
| \ .
( Style ‘ [ Diriver J
5. Click on File in the menu bar, then on Save in the File menu.
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Last, schedule a concurrent-request program called Audit: Dequeue Process to be
run periodically. This enables reports for the Audit Rules, Preventive Controls
Governor (change control), and Access Monitoring applications to display current
data, so the period at which you schedule the running of this concurrent program
depends upon the frequency with which you expect to run these reports. To
schedule the program:

1. Switch to the GRC Controls responsibility. (Use the Switch Responsibility icon,
sixth from the left on the tool bar.)

2. In the Navigator, select Requests: Run under the Administration heading.

3. In the Submit a New Request form, select Single Request and click the OK
button.

4. 1In the Submit Request form, select Audit: Dequeue Process in the Name field
(the program takes no parameters). Then click on the Schedule button.

5. In the Schedule form, select the Periodically radio button. In related fields, select
values appropriate for the schedule you want to set. Click on the OK button.

6. Inthe Submit Request form, click on the Submit button.

Different Hosts

If the database server and concurrent manager server are on different hosts, make
the following changes to the Tkprof script (LATKPROF.prog), which is located in the
PCG binary directory on the concurrent manager server. (The changed lines are
shown in boldface.) The value <db_login> is the user name to log on to the
database server, and the value <db_hostname> is the database server name.

#!/bin/sh

oracle login=S1

tempfile=$$latkprof.txt
temptrc=$$latkprof. trc

echo Temp file Stempfile

echo tkprof directory "$5"

pwd

tkfiles='ssh <db_login>@<db_hostname> ls $5'
for 1 in $tkfiles

do

echo processing $i

scp <db login>@<db hostname>:$i /tmp/S$temptrc
tkprof /tmp/S$temptrc /tmp/S$tempfile explain=$1
cat /tmp/Stempfile

rm /tmp/Stempfile

rm /tmp/S$temptrc

done

If you have multiple APPS schemas, the LA ENHNCMTMGR _PKG must be created as
a synonym under each schema. To perform this operation, run the following
command:

create synonym LA ENHNCMTMGR PKG for apps.LA ENHNCMTMGR PKG

If this is not set, the following error message appears when a user attempts to log on
to a read-only or MRC (multiple reporting currency) responsibility:

la _enhncmtmgr pkg not declared
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Oracle On-Demand

2-20

PCG requires access to various database objects on the APPS schema. Oracle On-
Demand, however, does not allow custom objects to refer directly to the APPS
schema. If you use Oracle On-Demand, you can create a custom APPS schema with
read-only permissions (customarily referred to as the APPSREADONLY schema). To
do so, run the following scripts, which the Installer has placed on your system. (If
you do not use Oracle On-Demand, you do not need to run these scripts.)

laa rd custom tab grants to apps.sql: This script is executed from XXLAAPPS.
It contains the grants having “WITH GRANT OPTION” for XXLAAPPS custom objects.

laa_rd apps views_syn to schema.sql: This script is executed from APPS. It
gives grants and creates synonyms in the destination schema for the identified
Oracle APPS tables.

laa_rd apps packages to schema.sql: This script is executed from APPS. It
gives grants and creates synonyms in destination schema for the identified
Oracle APPS packages.

laa_rd custom_packages to schema.sql: This script is executed from APPS. It
gives grants and creates synonyms in the destination schema for custom pack-
ages for the GRCC Suite.

laa rd custom tab to schema.sql: This script is executed from APPS. It gives
grants and creates synonyms in destination schema for the custom tables for the
GRCC Suite. This script need not be run if the destination schema is XXLAAPPS.

laa rd custom views to schema.sql: This is script is executed from APPS. It
gives grants and creates synonyms in the destination schema for the custom
views for the GRCC Suite.

laa rd cm_apps tables grants.sql: This script is executed from APPS. It gives
SELECT grants to the destination schema for Oracle APPS tables accessed by
GRCC control monitors.

laa rd cm_apps tab synonyms.sql: This script is executed from the destination
schema. It creates synonyms for Oracle APPS tables accessed by GRCC control
monitors in the destination schema.
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Validation

As a part of the installation process, the Installer programs complete several
“behind-the-scenes” tasks. Open Oracle E-Business Suite forms to confirm that
these tasks have been completed.

As you perform these validation steps, you may be instructed to “query for” a value.
If so, press the F11 key, type the specified value in a specified field, and then press
Ctrl+F11.

1. Log on to the System Administrator responsibility in Oracle E-Business Suite.

2. Select Application, then Register.

3. Inthe Application field, query for GRC Controls Custom. The form should
contain the following values:

O Applications
Shart
Application MNarme Basepath Description
l GRC Contrals Custam WALAAPPS  HHLAAPPS_TOP  |GRC Controls Custom Application =

4. Switch to the Application Developer responsibility.
* Select File in the menu bar.
»  Select Switch Responsibility in the File menu.
* A Responsibilities list appears; in it, select Application Developer.

5. Inthe Application Developer Navigator, double-click on Application, then
Form.
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6. In the Form field, query on LABIZ. The form should contain the following

values:

O Forms

Farm Application User Form Name

I|LAEIIZ |GRC Cantrols Custom |Orac|e Form Rules

|GRC Caontrals Oracle Form Rules

4]

7. Switch back to the System Administrator responsibility.

¢ Select File in the menu bar.

* Select Switch Responsibility in the File menu.
* A Responsibilities list appears; in it, select System Administrator.

8. In the System Administrator Navigator, select Security, then Responsibility,
then Request.

9. In the Request Groups form, query for GRC Controls Request Group. The form
should contain the following values:

Group
Application
Code
Description

Reguests

Type

|GRC Controls Reguest Group

|GRC Contrals Custom
LOGAPPSRG

|Request Group for GRC Controls Applications

MNarne

Application

I|App|icati0n

v||GRC Controls Custom

|GRC Controls Custam

Description

4]

GRC Controls Custom Application
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10. Still in the System Administrator responsibility, select Application, then Menu
in the Navigator. In the Menus form, query for LAAR NAVIGATE and confirm
the values shown in the following illustration.

Menu |LAAR_NAVIGATE M
User Menu Mame GRC Caontrals AppsRules

Menu Type | Standard

Description  Wenu for GRC Contrals Applications
Seg Prompt Submenu Function Description Grant

l 10 Preventive Contro |GRC Contrals: Oracle Em GRC Controls : Preventive Contral Givl =

a5 Flexfield Walues FMD Flexfields v
150 Oracle Audit AppsAudit form function v
160 GRC Controls Online Aud | Appsdudit Online form function v
170 Oracle Audit Report AppsAudit Repart form function v
205 Transaction Contr|GRC Controls: Access Gy GRC Controls : Transaction Control i
00 Administration  |GRC Controls: &Administrs GRC Controls Administration menu ¥
1100 |GRC Controls Fal GRC Controls MLS Form |GRC Controls MLS Form Prompts W

11. In the System Administrator Navigator, select Security, then Responsibility,
then Define. In the Responsibilities form, query for GRC Controls. (This is the
responsibility you would assign to Oracle E-Business Suite users so that they
can use PCG applications.)

Responsibility Name |GRC Caontrols

Application
Responsibility kKey |LAAPFPSRULES
Description
Available From
® Qracle Applications
© Oracle Self Service Web Applications
' Oracle Mohile Applications

GRC Controls Custom

Effective Dates
From 03-DEC-2008
To

GRC Contrals Applications Responsibilit:

Data Group
Standard

GRC Controls Custom

Marne

Application

Request Group

GRC Contrals AppsRul
Menu S Al o T Mame |GRC Controls Reguest Group
‘Web Host Name Application |GRC Controls Custorn
YWeb Agent Name
Menu Exclusions Excluded ltems Securing Attributes
Type MName Description
l Function hd =
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Switch to the GRC Controls responsibility and, in its Navigator, select Preventive
Controls Governor, and then Form Rules. Then do the following:

1.
2.

Select Tools in the menu bar, then Oracle Rules Configurations in the Tools menu.

An Oracle Rules Configurations form appears. Confirm that a value is displayed
in the UTL Path field:

";_9 COracle Rules Configurations

UTL Path | ATEIgituts
Library “ersion F.0.00
Farm “ersion 5.5.0.0.0
Package Yersion 5.1.0.0

Refresh Cache
Done

The UTL Path field value should match the name of one of the directories set
for UTL PATH in your environment. To confirm that it does, run the following
SQL Query to generate a list of those directories:

select value from gvSparameter where name='utl file dir'

Finally, confirm that appropriate values have been set for GRC Controls libraries:

1.

© Segment Values

With Form Rules open, click on GRC Controls Utilities in the menu bar, then
on Oracle Rules Library in the GRC Controls Utilities menu.

With a GRC Controls Libraries form open, click on Tools in the menu bar, then
on Value Sets in the Tools menu.

In the Name field of the Find Value Set form, enter the value LA% and click on
the Find button.

Select (one at a time) the LAAC_CATEGORY, LAAR_LIBRARY MODULES, and
LAAR_LIBRARY THEME entries. For each, confirm that a Segment Values form
displays ALL in the Values field for the Values, Effective tab. For example:

®alue Set ' Key Flexfield  Descriptive Flexfield © Concurrent Program
NETGERLAAR LIBRARY WODULERETE N L EE
Dependent Yalue Set

Independent Yalue

“alues (LAAR_LIBRARY _MODULES) v
Yalues, Effective 1 “alues, Hierarchy, Qualifiers
Translated Enabled
“alue Walue Description Fram To [ ]
lALL ALL tadule to include all rules v =1
Define Child Ranges Move Child Ranges Yiew Hierarchies )
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Installation History

You can review information about the installation of files for your PCG
implementation. To do so:

1. Log on to the GRC Controls responsibility in Oracle E-Business Suite.

2. In the Navigator, select Administration, and then Install History. The
Installation History form appears:

Install History Current File Versions

Install Datetime Release Component Host Mame  Install Status Product User Mame Schema Staging Dir

l 03-DEC-2008 04:19:48) |7_3_h31_ga |FRM londaon SUCCESS  Accesshonitor agl WHLAAPPS  flappsfagl/stage_lafARAinuy =
03-DEC-2008 04:19:48 |73 h31_ga |FRM londaon SUCCESS  OracleContral (agl HHLAAPPS  Vlappsfagl/stage lafARALinux
03-DEC-2008 04:19:45 |7_3_h31_ga |FRM londaon SUCCESS  SegregationOff agl HALAARPS  Vlappsfagl/stage_lafARALinux
03-DEC-2008 04:19:48 |73 h31_ga |FRM londaon SUCCESS  OracleFlow agl HHLAAPPS  Vlappsfagl/stage lafARALinux
03-DEC-2008 04:19:45 |7_3_h31_ga |FRM londan SUCCESS  Oraclefudit  agl HALAARPPS  Vlappsfagl/stage_lafARALinux
03-DEC-2008 04:19:48 |[7_3_h31_ga |FRM londaon SUCCESS  OracleForm  agl HHLAAPPS  Vlappsfagl/stage_lafARALinux
03-DEC-2008 04:19:45 |7_3_h31_ga |FRM londan SUCCESS  OracleCore ag HALAARPPS  Vlappsfagl/stage_lafARALinux
03-DEC-2008 04:14:27 [7_3_h31_ga DB london SUCCESS  Accesshonitar agl HHLAAPPS  lappsfagl/stage_lafARALinux
03-DEC-2008 04:14:27 |[7_3_h31_ga DB londaon MONFATAL_| OracleContral |ag HALAARPPS  lappsfaglistage_lafARLinux
03-DEC-2008 04:14:27 [7_3_h31_ga DB london SUCCESS | SegregationOff ag? HALAARPPS  flappsiaglistage_lafARALinuy o

Each row provides information about the installation of a program element —
for example, the top row in this illustration shows that the Access Monitoring
element for version 7.2.3 of the forms server was successfully installed.
Because there are several elements for each of the servers, a single installation
fills multiple rows in the grid- for example, the top seven rows in this figure
pertain to an installation performed on February 5.

3. To view a list of the files installed for a given element, click on the row for that
element and then on the Installed Files button. The following form appears:

Product Filenarne Revision Install Status

l AccessMDnitm{ LAAG frnb 1.4 Success =
Accesshonitor farms Success
Accesshionitor gro_73_menu_prompt_changes_script.sgl 1.1.2.1 Success
Accesshionitor la_gps_frmregister.sgl 1.4 Success
Accesshlonitor revisions 1.2 Success
Accesshionitor scripts Success

Close

Click on the Close button to clear this form.
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4. Finally, to review information about all currently installed files (regardless of
whether they were added in the most recent installation), click on the Current
File Versions tab:

Install History
File Marne Revision Install Tirme Product Release Cornponent  Install Status
[ 50 _characters.sq (] D3-DEC-2008 04:14:27 OracleCore  [7_3_b31_ga DB [Success 2
| jcusTOM pl 1.2 03-DEC-2008 04:19.48 OracleCore  [7_3_b31_ga FRM |Success N
| [CustomException class UMKMOWMN  03-DEC-2008 04:14.27 OracleCare  [7_3_b31_ga DB [Success
| [EntityName.class UNKNOWM  03-DEC-2008 04:14 27 OracleCore  [7_3_b31_ga DB |Success
| [EntityName java [1.2 03-DEC-2008 04:14:27 OracleCore  [7_3_b31_ga DB |Success
|GRC_BIP_LOAD_CP_REGISTER.sql 1123 03-DEC-2008 04:14:27 OracleContral [7_3_b31_ga DB |Success
' |GRC_BIP_RPT_UPLOAD. prag [1.124 03-DEC-2008 04:14:27 OracleCore  [7_3_b31_ga DB |Success
|GRC_BIP_RPT_UPLOAD &g 1122 03-DEC-2008 04:19:48 OracleControl [7_3_b31_ga FRM |Success
| |Hide_722_AppsAcress.sl 1.2 03-DEC-2008 04:14:27 OracleCore  [7_3_b31_ga DB |Success
[IDULiI§1 class UNKMOWN  03-DEC-2008 04:14:27 OracleCore  [7_3_b31_ga DB |Success
" |ioutis2.class UMKMOWMN  03-DEC-2008 04:14.27 OracleCare  [7_3_b31_ga DB |Success
| loutil.class IUNKMOWM 03-DEC-2008 04:14.27 |OracleCore  7_3_b31_ga DB |Success =

5. To close the Installation History form, click on its x symbol.
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